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Introduction 

Overview 

An effective email marketing system should include the following 
tools: 

- Automated email sequences that drip on the contacts over time 
to build trust and convert the subscribers into active and happy 
customers. 

- An email scheduler for planning announcements, newsletters, 
and special occasion emails weeks or even months in advance. 

- A relevant reporting of email campaign performance with seed-
based Inbox delivery testing, spam filter and authentication testing, and 
delivery duration monitoring. 

- A simple way to create sign-up forms and allow the user to auto-
populate their contact lists. 

- A professional collection of quality responsive HTML email 
templates that the user can install and use for their newsletters on the 
fly. 

- An automated way of processing bounce and unsubscribe 
emails to be in compliance with the CAN-SPAM law in various 
countries. 

- Training and support from those who have years of experience 
in email marketing systems, management and success. 

With G-Lock EasyMail7, the user has the right email marketing 
software system to help them maintain and grow their business. 

G-Lock EasyMail7 is a powerful in-house email marketing 
solution that eliminates the complexity and expense of operating a 
third-party email service. It allows users to manage their email lists, 
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create and send beautiful email newsletters, and process bounce and 
unsubscribe email messages. 

G-Lock EasyMail7 works as a front-end to SMTP servers and 
delivery services like Amazon SES, SendGrid, Mailgun, SparkPost, 
and others. 

G-Lock EasyMail7 is built on a client-server model and consists of 
two components: EasyMail7 Server and EasyMail7 Client with 
beautiful, easy to use and understand user interface. 

The user can install the EasyMail7 Server on a local computer or 
Windows Server 2008/2012/2016/2019, Amazon EC2 or Windows 
Azure Virtual Machine where the user can deploy his own customized 
Windows Server. The EasyMail7 Server runs as a service in the 
background and does most of the work: send out messages, check for 
incoming returned messages and update the contact lists. 
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The EasyMail7 Client can be installed on as many computers as 
the user wants. Users login to the EasyMail7 Server from their 
computers and manage email lists and campaigns. 

Each user can work within his own workplace on the EasyMail7 
Server. And several users can work within one workplace 
simultaneously.  

With its emphasis on business productivity, safety, ease and 
convenience of use G-Lock EasyMail7 is the unique client-server 
email marketing solution for Windows that allows to: 

- send emails to large contact databases; 

- manage contact lists and send email campaigns from a remote 
location; 

- multiple employees to work with the program simultaneously; 

- send emails using the Amazon SES API, SendGrid, Mandrill, 
MailJet and SMTP settings of other email senders; 

- use automated emails to convert prospects into customers; 

- automatically update, insert and delete bounce emails from 
remote databases; 

- run email campaigns from any device via any browser using a 
simple web client; 

- keep the user’s data secure using encrypted connection 
between EasyMail7 Server & Client. 
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Free Trial Limitations 

The free trial version of G-Lock EasyMail7 is limited to: 

- 14 days of use; 

- 250 messages per hour; 

- 1,000 messages per day; 

- 12,000 messages per month; 

- 3 credits for Inbox delivery and spam filtering tests. 

After the trial period expired, the user must either buy the license 
for G-Lock EasyMail7, or discontinue using the program. 
 

License Model 

G-Lock EasyMail7 license is sold as an annual subscription. 
When the user purchases the license, they receive 12 months of free 
updates for the EasyMail7 Server and Client from the date of their 
purchase – be it a minor program update or a major new version.  

To get another year of free updates, the user must pay a small 
maintenance fee. If the user chooses not to renew, they can continue 
using the last version they are eligible to use.  

There are unlimited features in ANY paid version. G-Lock 
EasyMail7 is backed by a 60-day unconditional money-back 
guarantee. 
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The Cutting Edge 

Multiple Users and Workplaces 

If the user has a paid license for G-Lock EasyMail7, he can create 
multiple users and workplaces on the EasyMail7 Server and then grant 
users access to one or multiple workplaces. 

A workplace includes email server accounts, email templates and 
drafts, sent items, contact groups (internal and external lists), 
scheduler, autoresponders and Bounce Handler. 

Each user has the full control under his own workplace(s) 
allocated to him by admin. Plus, admin can set sending limitations for 
the workplace such as monthly sending limits and maximum sending 
slots to control the server load. 
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The user must install only the EasyMail7 Client on his/her 
computer. After the installation, the user starts the EasyMail7 Client 
and enters his login information to connect to the EasyMail7 Server. 

Then the user can choose the workplace to work with. If the user 
is granted access to one workplace only, the workplace opens 
automatically.  

The program allows several users to manage contacts and 
mailings within the same workplace at the same time.  
 

Super Fast Import 

G-Lock EasyMail7 allows the user to quickly import contacts 
without using the Import Wizard.  

It takes just a few mouse clicks. The user selects the file and the 
fields in the file/database that he wants to add to the group. 

G-Lock EasyMail7 supports the import from MS Access, MS 
Excel 97-2003, MS Excel 2007-2013, CSV Text file, MySQL or MS 
SQL server database. 

The program imports a million emails in just 43 seconds while 
some of the competitors’ programs take an hour or even more! 



9 
To learn more about G-Lock EasyMail7, visit http://easymail7.com 

 

 

 

 

 

 



10 
To learn more about G-Lock EasyMail7, visit http://easymail7.com 

Integration with CRM Databases 

The user can directly connect to a MS Access, MS Excel 97-
2003, MS Excel 2007-2013, CSV Text file, MySQL, MS SQL server 
database or WPNewsman subscribers’ lists.  

G-Lock EasyMail7 connects to MySQL server directly - it's not 
necessary to install an ODBC connector. 

The user creates a link to the database only once and the 
program will always read an up-to-date list from the database.  

The user does not need to re-import an updated contact list into 
the program. 
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Integration with G-Lock WPNewsman Plugin 

G-Lock WPNewsman is a newsletter plugin for WordPress that 
allows to put the subscription form on the site and collect subscribers 
using a confirmed opt-in method.  

The user can use WPNewsman completely free to convert 
website visitors into email subscribers. The user can create a direct 
link to the subscribers’ lists stored in WPNewsman through API and 
send them email newsletters using G-Lock EasyMail7.  
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Multiple Sending Options, Amazon SES API 

In G-Lock EasyMail7, the user can customize the From name, 
From email address, Reply email address and Return email address 
and use the suitable delivery mode including the custom SMTP server, 
ISP SMTP server, or SMTP settings of any 3rd party sender like 
SparkPost, SendGrid, Amazon SES and others. 
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G-Lock EasyMail7 is integrated with the Amazon SES API. If the 
user can't use their ISP SMTP server due to email sending restrictions 
and doesn’t have their own SMTP server, they can signup with 
Amazon SES and configure G-Lock EasyMail7 to use Amazon SES 
API or SMTP.  

 

 

Another advantage of using Amazon SES is that they care about 
bounce and feedback loop emails. No need for the user to signup for 
feedback loops with many ISP to be alerted when someone reports the 
email as spam.  



14 
To learn more about G-Lock EasyMail7, visit http://easymail7.com 

Amazon SES will send bounce and feedback loop emails to the 
user and then the user can process them with the Bounce Handler 
included into G-Lock EasyMail7.  

When the user sends emails through the Amazon SES API, G-
Lock EasyMail7 automatically controls the sending rate allowed for the 

user’s account to comply with the Amazon SES sending policy. 

 

Responsive HTML Email Templates Store 

G-Lock EasyMail7 is supplied with a rich store of professionally 
designed responsive HTML email templates. The user can browse the 
store and download any templates for their email newsletters. All 
templates are tested in different email applications. 

 
 



15 
To learn more about G-Lock EasyMail7, visit http://easymail7.com 

The user can customize the template by inserting their logo, 
images, text, links, etc.  

G-Lock EasyMail7 includes a fully-featured context-sensitive 
message editor so the user can create a HTML email directly in the 
program. There are many customization options (body, header, footer, 
colors etc.) for the templates and messages. 

In addition, the user can create their own layout in any standalone 
HTML editor like Adobe DreamWeaver, FrontPage, or Microsoft 
Expression Web and load it into G-Lock EasyMail7.  

G-Lock EasyMail7 supports the import of email messages from a 
web page, HTML file, ZIP file and EML file. 
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Easy Image Compression and Upload 

The user can utilize G-Lock EasyMail7’s “Image Wizard” to re-
size, crop and compress the pictures before inserting them into the 
template or message. 
 

 
 

To decrease the message size, speed up sending, save 
bandwidth, money (some email services like Amazon SES charge 
users for data transfer) and the image loading time, it’s recommended 
to upload the images to the website and link to them from the 
message. 

The user can upload the pictures to their web server directly from 
G-Lock EasyMail7 without using a 3rd party FTP client. 
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G-Lock EasyMail7 has the built-in FTP client. The user just needs 
to enter the FTP server information, create a message and insert 
pictures from a local folder, then choose the FTP server to upload the 
pictures to.  

G-Lock EasyMail7 will upload all pictures used in the message to 
the selected FTP server and automatically replace local paths of the 
images with the paths on the web server. 

 

 

Multiple Languages, Special Symbols 

In G-Lock EasyMail7, the user can type the message text in more 
than one language to make sure their non-English subscribers can 
read it. No need to adjust any settings or set the special encoding to 
make a multilingual message open correctly in email clients. All is done 
automatically by the program. 

Another cool feature the user can take advantage of is the 
support of special symbols in the message body and Subject line to 
grab the recipient’s attention. G-Lock EasyMail7 allows to insert most 
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popular arrows, numbers, symbols and currency symbols into the 
message subject and body. 
 

 

 

Scripting Capability 

G-Lock EasyMail7 allows the user to write the script to perform 
various operations with the fields’ values during email sending. 

For example, with the use of the script it’s possible to change the 
first lower case letter in the subscriber's first name into the upper case 
letter, replace a missing subscriber's name with any word for example 
"Subscriber", add http:// at the beginning of URLs, generate random 
numbers and use them in the email body and subject etc.  
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All the fields in the contact group are available for the use in the 
script. 

 

 

 

Customizable Unsubscribe Link 

To comply with CAN-SPAM law, G-Lock EasyMail7 is supplied 
with a ready to use unsubscribe link. The user can merge the 
unsubscribe link into the message with just two mouse clicks.  

The user can change the default unsubscribe link and links to 
their social profiles in the Workplace settings. 
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In addition to the unsubscribe link and social links in the 
Workplace settings which apply for all groups and databases within the 
current workplace, the user can have custom unsubscribe link and 
social links for each group/database.  

The user can enter different unsubscribe links for groups under 
the Group Links tab when he creates a group or link to a contact 
database.  

Group links have priority and will be used by the Dynamic Fields 
option in the first place. 
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Inbox Placement and Spam Filter Testing 

G-Lock EasyMail7 is integrated with the GlockApps service and 
provides a relevant reporting of email campaign performance with 
seed-based Inbox delivery testing, spam filter and authentication 
testing, and delivery duration monitoring. 

The user can test email delivery with different Internet service 
providers to make sure that the email is delivered to the Inbox, not the 
spam folder, before sending a real email campaign.  
 

 
 

From the Inbox delivery testing report the user can see how his 
message is treated by major Internet providers around the world and 
whether it is delivered to the Inbox, spam folder or blocked before 
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reaching the recipient's mailbox. In Gmail the user will see if his 
message is delivered to the Primary or Promotions tab. 

Spam filter testing helps the user identify which filters are blocking 
his emails.  

Sender authentication testing checks the user’s authentication 
and reports whether the email is passing DKIM and SPF 
authentication. 

Delivery duration tracking shows how much time the email 
delivery takes at different ISPs and helps determine if there is an issue 
with ISP throttling. Rather than blocking emails altogether, some ISPs 
will delay the delivery of emails when the volume passes a certain 
threshold. This can be particularly harmful for time sensitive 
promotions or important transaction emails. 

 

Email Campaign Scheduler 

G-Lock EasyMail7 allows the user to schedule email campaign for 
any date or time. For example, the user can schedule the email 
campaigns for a night to avoid the mail server overload and achieve a 
higher email sending speed. 

The Scheduler settings are very flexible. The user can set G-Lock 
EasyMail7 to send emails at a regular time interval: hourly, daily, 
weekly, or monthly. The user can even send emails, for example a 
welcome message, automatically to only new recipients every day or 
week. 
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Online Subscription Forms 

If the user installs the EasyMail7 Server on a computer that is 
always online (Amazon EC2 instance, Windows VPS, centralized 
network server etc.), they can create subscription forms, place them on 
their website and collect email leads into the EasyMail7 groups in real 
time. 

EasyMail7 allows to organize a single opt-in or confirmed opt-in 
process. The program has pre-configured email templates and action 
pages for the subscribe and unsubscribe process. The user can edit 
and customize the email templates and action pages as they like. 
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Automated Emails 

Setting up an automated email series is a key first step to 
effectively using opt-in emails to your business.  

With automated emails in G-Lock EasyMail7 the user can send 
pre-written follow-up emails sequentially and automatically to the 
subscribers over time after they’ve subscribed to the list — great way 
to improve the reader’s experience and convert subscribers into 
customers. 
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For example, the user can create a series of automated emails 
containing unique content and schedule the first one to go out 
immediately or in a few hours/days after the subscriber was added to 
the list or after any period of time has passed, the second – in 48 hours 
after the first one, the third – in 72 after the second one etc. 

The best part is that after the automated emails are setup, the 
user doesn’t have to think about it again — G-Lock EasyMail7 makes 
sure email campaigns get to the subscribers, right on time.  

As far as the user adds new subscribers to the list, new 
subscribers will receive the email series starting from the first email. 
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Real Time Email Tracking 

G-Lock EasyMail7 is integrated with G-Lock Analytics, Google 
Analytics, and Piwik Analytics tracking services. 

G-Lock Analytics from http://glockanalytics.com is an extremely 
sophisticated email tracking service that allows the user to track email 
opens, link clicks, email forwards and prints.  

Plus, it can trace the geographical location of the recipient so the 
user will understand what countries the subscribers are from.  

In addition, the user can get a report about the email clients their 
recipients used to open the message and save time by customizing 
future messages for the most used email clients only. 

The user can see the email tracking statistics overview right 
inside G-Lock EasyMail7. The Overview shows the open rate and click 
rate, the number of opens, clicks, forwards, and unsubscribes. Plus, 
the user can quickly see how many recipients read, glanced and 
skimmed the email. 

To get the full campaign statistics, the user must click on “View 
Details”. The user will be redirected to the full campaign reports in his 
account on G-Lock Analytics website. 



27 
To learn more about G-Lock EasyMail7, visit http://easymail7.com 

 
 

To track what recipients do on the user’s web site after clicking a 
link in the message, the user can use Google Analytics or Piwik 
Analytics. 

Google Analytics generates detailed statistics about the visits to a 
website. The user can find out how many customers they’re attracting, 
how much they're selling and how users are engaging with their site. 

Piwik Analytics is yet another tracking service that lets the user 
track how efficient various marketing campaigns are in bringing visitors 
to their website (visits, page views, etc.), how well these visitors 
convert and how much revenue they generate. 
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Automated Bounce Handler 

With the Bounce Handler supplied with G-Lock EasyMail7 the 
user can quickly process bounce messages after each email 
campaign. The Bounce Handler provides the most accurate bounce 
detection solution. It downloads bounce messages and classifies them 
as hard bounce, soft bounce, mail block and abuse/fraud feedback 
reports. 

The Bounce Handler can automatically unsubscribe or delete 
bounce email addresses from internal groups. Plus, it can 
automatically update external databases, insert and delete bounce 
emails from external databases — this unique capability is not 
available in any competitor’s program! 
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In addition, the Bounce Manager can determine and delete these 
types of emails from the server: transient bounce, challenge-response 
and auto-reply messages.  

The Bounce Handler helps the user prevent their IP address from 
being blacklisted for repeated sending to invalid email addresses and 
keep a good sender reputation.  

Plus, future email campaigns will be sent faster because G-Lock 
EasyMail7 won't waste time for trying to send the message to invalid 
recipients. 
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Easy Data Backup 

Users and workplaces are stored on the EasyMail7 Server. To 
protect the EasyMail7 Server data from damage or loss, the user 
logged in admin can create the data backup on the EasyMail7 Server, 
download the backup file to a local computer and save it to a safe 
place. Backup includes all users and workplaces stored on the 
EasyMail7 Server.  
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The user can save the backup manually at any time, or enable the 
automatic backup creation. The user can choose to save or not to save 
sent items to backup to have a lesser backup file size. 

Backup is made online which means the EasyMail7 Server 
doesn't stop and the program continue working while the backup is 
being created. 
 

 
 

When the user needs to restore data after re-installation or 
moving the EasyMail7 Server to a different location, the user can 
upload the backup file to the server and restore data from backup.  

All is done within G-Lock EasyMail7. No need to use 3rd party 
tools for creation, download and upload of the backup file. 
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Simple Web Client 

G-Lock EasyMail7 has built in Web Service and offers a RESTful 
interface for consuming JSON content via AJAX or mobile clients. We 
included the basic demo web client into the program installation which 
shows how to create a RESTful JavaScript client. 

The user can optionally install G-Lock EasyMail7 web client when 
they are installing G-Lock EasyMail7. In the current version of the web 
client the user can compose and send an email message, save an 
email message as a draft, edit and delete templates and drafts, view 
contacts in internal and external groups (databases), and view sent 
emails in the Outbox. 

The user can login into the web client in any browser on any 
device including iPad, Android tablet pc, Windows tablet pc etc.  
 

 

 

 

 



33 
To learn more about G-Lock EasyMail7, visit http://easymail7.com 

Installation, First Login and Activation 

Installation 

To install G-Lock EasyMail7:  

1. Download the free trial G-Lock EasyMail7 from 
http://easymail7.com   

2. Extract the files from the easymail7.zip file to the temp 
directory.  

3. Run the easymail7_setup.exe file.  

4. Follow the steps of the installation process. 

5. Choose the EasyMail7 components that you want to install 
during the setup process. To start, you can install both the EasyMail7 
Server and Client onto your personal computer or server. 

 

6. Finish the installation process. 
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First Login 

If the program is successfully installed, the EasyMail7 Server 
automatically starts and runs as a service on the background. 

Start G-Lock EasyMail7 Client component. On the login screen 
enter the IP address of the server where the EasyMail7 Server 
component is installed. 

If you installed the EasyMail7 Server and Client on the same 
computer, you can enter your computer's name, or localhost, or 
127.0.0.1 into the "EasyMail7 Server" field. 

The port number is set automatically. The EasyMail7 Client uses 
the port 50888 to connect to the EasyMail7 Server. 

For the first login to the EasyMail7 Server use the default username 
and password (case sensitive!): 

User Name: Admin 
Password: Admin 

 
Click “Connect”. 
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Trial Version Activation  

After login, you must get the key and activate the trial version of 
G-Lock EasyMail7. 

Type your first name, last name and email address on the 
activation screen and click the “Get Free Key” button. 

The message with your personal key will be sent at your email 
address so make sure you entered a valid email address. 
 

 

 

Copy-paste your key on the activation screen.  

Click “Activate”. 
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After the activation the program will ask you to change the default 
password to protect your G-Lock EasyMail7 data from an unauthorized 
access. 

 
 

Type your new password on the “Change admin password” 
screen. You can also enter your first name, last name and email 
address. 
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It’s highly recommended that you copy your new password and 
save it to a safe place. If you forget the password, there is no way to 
restore it and you won’t be able to access the EasyMail7 Server. 

Click on “I copied my password. Please close this form” button.  

Be sure to save your password to a place where you can easily 
find it. 
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Login again using your new password (and your new user name if 
you have changed it too).  

You become the SuperAdmin. As SuperAdmin, you can manage 
the EasyMail7 Server and server backups, manage users and 
workplaces, assign users to workplaces, create contact groups, 
messages and send messages to groups. 

 

Get Started 

After you login with your new password, click on the Workplace 
menu at the top left corner of the program window and navigate to the 
“Get Started” section. 

Follow these quick steps to send your first message with G-Lock 
EasyMail7:  
 

Add Email Account 

The first step is to create an email server account where you will 
enter your sender information and SMTP settings. 

Click on “Connect SES/SMTP” in the “Get Started” section. 
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Enter your sender information: Account Name, From name, Email 
Address, Reply Email Address and Bounce (Return) Email Address. 

Then click on the Delivery Options tab. 

Enter the information about the SMTP server you will send emails 
through. G-Lock EasyMail7 can send emails through any 3rd party 
SMTP server. It can be your dedicated SMTP server, or SMTP server 
of your Internet service provider (ISP).  

In addition to that, you can use the SMTP settings of any 3rd party 
email sender such as SparkPost, SendGrid, Amazon SES and others. 
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Some SMTP servers are predefined in G-Lock EasyMail7 so you 
can choose the SMTP server from the menu. Then enter your login 
username and password. 

Click “Test” to check your SMTP settings. 

If they are correct, click OK to save the account. 
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Import Contacts 

Now you can go to the second step and import contacts. 

G-Lock EasyMail7 allows you to create a group and import 
contacts at one go without the need to use the import wizard. 

Navigate to the “Get Started” section and click on “Import 
Contacts”.  

Select the option depending on the format of the file/database you 
want to load the contacts from.  
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Select the file on the disk and click “Open”. 

Enter a group name. By default the program uses the file name as 
the group name. 

Put the check marks for the fields that you want to import into the 
group and do the field mappings. If the field names in your file match 
the field names in G-Lock EasyMail7, these fields will be mapped 
automatically. 

If the field names in the file do not match the field names in G-
Lock EasyMail7, map the fields manually by choosing the right field 
name from the drop down menu in the "EasyMail Field" column.  
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The field containing the email address is required for mapping. 
Other fields are optional. 

After the fields are mapped, click “Create”. 

Important! If you have a Windows 64-bit system or installed the 
EasyMail7 Server on a clean machine without Microsoft Office, then 
you must download “Microsoft Access Database Engine 2010 
Redistributable” (AccessDatabaseEngine.exe) for 32-bit systems from 
http://www.microsoft.com/en-us/download/details.aspx?id=13255 and 
install it in the passive mode to be able to create groups directly from 
MS Access, MS Excel 97-2003, or MS Excel 2007-2013 files.  

Go to Start -> Run. 

Type the local path to AccessDatabaseEngine.exe /passive 

Example: D:\temp\AccessDatabaseEngine.exe /passive 

Click OK. 
 

Add Bounce Email Account 

To comply with the CAN-SPAM law, you must process bounce 
emails after each sending and delete or unsubscribe them in your list.  

It’s recommended to setup a separate email address for bounce 
messages and not mix them with regular emails in your main mailbox. 

To quickly add your Bounce Email Address to the Bounce 
Handler in G-Lock EasyMail7, go to your Outgoing mail Account, open 
it in the Edit mode and click on “Add to Bounce Handler” button. 
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Enter your mail server address, password and other required 
information in the Bounce Account settings. 

Select the action what the program will do with bounce emails: 
delete from contact groups or unsubscribe in all groups. 

Click “Test” to check if your settings are correct. 

Click OK to save the Bounce Account settings. 
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Create Message 

After you added an outgoing email server account, a bounce 
email account, and imported email contacts, you can create an email 
message. 

Return to the main program window and click “New Message” 
under the Home menu. 
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Type the message text in the "Edit Message" window. Or, you can 
click on the Source tab at the bottom of the window and copy-paste the 
HTML source there. 

You can also load an email message from file or web page. 

 Click on the File menu and select "Load Web Page", "Load 
HTML File", "Import Template" or "Import from EML File" option 
depending on where you want to load the message from. 

 

 

You can fully customize the message using the HTML options 
and dynamic fields.  
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Under the Insert tab, you will find the insert options such as insert 
a table, attachment, symbol, picture, link, and line. 

When the message is finished, you can click “Save” and save it to 
the Drafts folder. 

If you don’t have your own email design, you can use any HTMl 
template from the EasyMail7’s template store for inspiration. 

Click on "Template Store" under the Home menu. 

Choose the template and click on "Download template”. 
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When the template is installed, close the Template Store and click 
on “Templates” in the left pane.  

Hover the mouse over the template name and click on “Edit 
Template”. 

 
 

The message editor will open where you can customize the 
message as you need by adding your company name, message text, 
dynamic fields, etc. 

When you finished the customization, click “Save”. 

 

Test Inbox Placement and Spam Score 

Before you send the message to your real email contacts, it is 
highly recommended that you test your email deliverability with 
different mailbox providers to make sure that your email is delivered to 
the Inbox, not the spam folder.  
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It also helps you monitor your sender reputation with different 
email service providers and make sure that you are in good standing 
with top domains on your list. 

To make the Inbox delivery and spam test, double-click on the 
message in the Drafts or Templates folder. 

Then click “Send” and choose "Send Spam Test" from the "Send" 
button menu. 
 

 

 

Since Inbox Placement and span score tests are made through 
our GlockApps testing service, you’ll need to create an account with 
GlockApps the first time.  

If you already have an account, simply login on the login form.   
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Then, select the providers you want to check your email with and 
click "Start." 

G-Lock EasyMail7 will send your message to the seed list of 
email addresses with chosen service providers, and you will get the 
delivery report within a few minutes. 

To see the test delivery report, go to the Outbox and click on 
"View Report" on the test message.  

The report presents: 

- Inbox/Spam/Missing rate; 

- sender authentication test (DKIM and SPF); 

- sender IP reputation; 

- spam filter tests; 

- Inbox placement test; 

- delivery duration. 

 



51 
To learn more about G-Lock EasyMail7, visit http://easymail7.com 

 

 
 

Send Test Message 

In addition to the Inbox Placement and spam score test, you can    
quickly send a test message to yourself to check if it looks well in the 
email client when received.  

Or, you can create a group with your test email addresses and 
always use that group for sending a test message before each 
campaign.  

To send a test email message, select “Send Test” from the 
"Send" button menu. 
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On the "Send Test Email" window select the option "To email:" or 
"Group:". 

The "To email:" option allows you to quickly send a test message 
to one or several email addresses without adding them to the group.  

Email addresses must be separated by commas or semicolons. 

Important! When you send a test email using the "To email" field: 

1. the Global Exclusion List does not work (if the email address is 
on the Global Exclusion List, the test message will still be sent to that 
email); 

2. group merge tags in the email do not work. Only the merge 
tags from the Workplace Settings such as the unsubscribe link and 
social links work. 
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If you have a group with test email addresses, select the "Group:" 
option and then select your test group from the menu. 

You can add email addresses to which you do not want to send 
the test email to the Exclusion list by using the > button. 

Click "Send". 
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Check mail on your test email addresses to see how the message 
displays. If any corrections are needed, you can make them now and 
re-send a test message. 

  

Send Message to the Group 

After testing your Inbox delivery and making sure that your email 
is delivered to the Inbox with your top domains, you can send an email 
campaign to your contact group.  

Select the group in the “Group” field. 

Click “Send”. 

Select “Send Now” from the “Send” button menu. 
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You can watch the sending process in the Outbox. This is where 
sent emails are stored. 

After the sending is complete, you can click on “View Log” and 
look at the general sending log of the message. 

In addition, you can click on “Processed”, “Sent” and “Failed” to 
look at processed emails (sent + failed), sent and failed (not sent) 
emails. 
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Work with G-Lock EasyMail7 Web Client 

You can login into G-Lock EasyMail7 web client in any browser on 
any device including iPad, Android tablet pc, Windows tablet pc etc. 
and run an email campaign, check how the email campaign was sent, 
look through the contacts or simply check the data you have on the 
EasyMail7 Server. 
 

Install G-Lock EasyMail7 Web Client 

Check the "Install Web Client" option during the setup process. 

Click “Next”.  

 

 

Finish the setup process. 
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Login into Web Client 

After you installed G-Lock EasyMail7 web client, login into it in 
your browser. 

Open the URL http://[EasyMail7 Server IP]:50888/wps/www in the 
browser. 

Replace [EasyMail7 Server IP] in the URL with the IP address, or 
computer name, or domain name where the EasyMail7 Server is 
installed. Example: http://127.0.0.1:50888/wps/www 

Login with your user name and password. 

 
 

Click "Sign in". 

After login select the workplace you will work within. 
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In G-Lock EasyMail7 web client you can compose an email 
message from scratch or from an existing template, but you cannot 
import the message from a file or web page. 
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Use the options of the HTML editor to compose the message. Or, 
you can click on "Source" and copy-paste your HTML source. 

Important! In the web client you cannot use the Merge menu. To 
merge the contact's data, unsubscribe link or social links into the 
message, type the correct merge tags manually. 

 

 

In the web client you can only view the contacts in internal groups 
and databases. You cannot create new groups or links to databases.  

Neither can you edit, delete, add new contacts to the group or manage 
the exclusion list.    
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To view contacts: 

Switch to the "Contacts" tab. 

 
 

Click on the group name or database link name. 
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Support & Contact 

G-Lock EasyMail7 has a support page at 
http://easymail7.com/contact-support/ where you can ask for a solution 
to your problem using the contact form. We usually reply within 24 
hours on business days. 

Also you can contact us via email at support@glocksoft.com or 
via a live online chat on our main website http://www.glocksoft.com. 
The chat is available on business days during our working hours 10:00 
– 18:00 +3GMT. 

 
 

About G-Lock Software 

G-Lock Software develops software for different programming 
environments. Currently, the company’s emphasis is on tools and 
applications in the field of email marketing and SEO.  

Among its major products are G-Lock EasyMail7 client-server 
email marketing software, G-Lock Analytics real time email tracking 
system, Glock Apps email deliverability testing service, Advanced 
Email Verifier email list cleaner and verification software, G-Lock Email 
Processor advanced email processing and parsing software, and G-
Lock WPNewsman WordPress newsletter plugin.  

For more information, visit the company’s website at 
http://www.glocksoft.com 
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Additional Resources 

G-Lock EasyMail7 download:  
http://easymail7.com/downloads/ 

Key features:  
http://easymail7.com/features/ 

Tutorials:  
http://easymail7.com/tutorials/ 

FAQ: 
http://easymail7.com/top-questions-easymail7/ 

Knowledgebase: 
http://support.glocksoft.net/kb/12-g-lock-easymail7 
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